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				Állomány hibák
			

			
		
			
Szeretnénk arra koncentrálni, hogy megelőzzük az esetlegesen hibásan, vagy nem tökéletesen leadott állomány leadásokat, ezzel időt és költséget, valamint bosszúságot megspórolva az egyre inkább rövidülő gyártási folyamatokban.




E miatt kívánunk segítséget nyújtani PDF írási segédletünkkel, valamint az elkészült PDF-ek ellenőrzését támogató PDF ellenőrzési segédletünkkel. Sajnos a PDF-ek komplexitása miatt ezekkel sem mindig könnyű kiszűrni, vagy javítani a leggyakoribb állományhibákat, ezért célszerű ezekkel tisztában lenni, és a forrásfájlban megszüntetni ezek okait.









Állományokban gyakrabban előforduló hibák, és azok hatásai




	Probléma	Hatása lehet	Preflight 
ellenőrzi?
	1. Nem megfelelő terjedelem	Árkülönbség a megrendeléshez képest	Nem
	2. Nem megfelelő színszám	Árkülönbség a megrendeléshez képest	Nem
	3. Nem megfelelő oldalméret	Árkülönbség a megrendeléshez képest	Nem
	4. Hiányzó kifutó	Vágási probléma	Nem
	5. Felesleges segédjelek	Vágási probléma	Nem
	6. Vágásközeli tartalom	Vágási probléma	Nem
	7. Nem definiált vágás	Vágási probléma	Igen
	8. Nem megfelelő színrendszer (RGB)	Színeltérés	Igen
	9. Nem megfelelő színprofil (ICC)	Színeltérés	Igen
	10. Rossz felülnyomás	Színeltérés	Nem
	11. Fehér felülnyomott elemek	Színeltérés	Igen
	12. Regisztrációs szín vágott méreten belül	Nyomtathatósági probléma	Igen
	13. Vékony vonalak több színből	Nyomtathatósági probléma	Nem
	14. Túl nagy festék összfedettség	Nyomtathatósági probléma	Nem
	15. Alacsony felbontás	Pixeles nyomat	Igen
	16. Nem beágyazott font	Karaktervesztés	Igen
	17. Rossz stanckontúr szeparáció	Stancolási probléma	Nem
	18. Nem beazonosítható oldal	Rossz oldalsorrend	Nem












1. Nem megfelelő terjedelem




Ha az állományban leadott oldalak száma nem egyezik meg a megrendelésben leadott terjedelemhez képest, akkor annak hatása lehet a termék előállítási árára! 




Tipp: Ne csak technológiai megfelelőségre törekedjen a PDF-ben, hanem annak tartalmát ellenőrizze a megrendelésben leadottakhoz is!













A PDF oldalszám és a megrendelésben leadott tejedelem azonos.







Több oldal érkezett mint ami a megrendelésben leadott terjedelem.



















2.   Nem megfelelő színszám




Fontos kritérium a leadott állománnyal kapcsolatban, hogy a PDF színcsatornáinak száma egyezen meg a megrendelésben meghatározott színszámmal! Tehát a legalább egy direkt színnel (Pantone) is nyomtatandó termékekhez leadott állomány nem megfelelő, ha abban minden elem CMYK értékekre van bebontva. Ugyanakkor az sem megfelelő ha egy CMYK-val nyomtatandó állományban véletlenül direktszín csatorna maradt. Továbbá gyakran előforduló hiba még az egyszínes (például csak fekete szöveget tartalamazó) termékek esetében, hogy az állományban marad valamilyen CMY színkitöltéssel is rendelkező elem.




Tipp: Ne csak technológiai megfelelőségre törekedjen a PDF-ben, hanem annak tartalmát is ellenőrizze a megrendelésben leadottakhoz!













Egy szín fekete nyomás a megrendelésben és az állományban is.







A megrendeléshez képest CMYK-ban leadott állomány.



















3.   Nem megfelelő oldalméret




Nem megfelelő oldalméretnek tekintjük azokat az állományokat, ahol a fájlban meghatározott végleges vágott méret eltér a számunkra leadott megrendelésben szereplőtől. 




Tipp: Ne csak technológiai megfelelőségre törekedjen a PDF-ben, hanem annak tartalmát is ellenőrizze a megrendelésben leadottakhoz!













A megrendeléssel megegyező méret.







Méreteltérés a megrendeléshez képest.



















4. Hiányzó kifutó (bleed)




A Kifutó hiánya vágási problémákat okozhat az olyan grafikák esetében, amelyek teljesen a lap széléig érnek. Ebben az esetben ugyanis nagyobb területet kell megnyomtatni, és azt kisebbre vágni, hogy elkerülhető legyen a vágási pontatlanságból adódó esetlegesen kivillanó fehér (nyomatlan) rész megjelenése. Kérjük, hogy a kifutó meglétét mindig ellenőrizze a kész PDF-ben, és állítsa be az állomány oldalgeometriáját a megfelelő trimbox méret beállításokkal. A javasolt kifutó mérete 5 mm legyen, táblaborítók esetén pedig 15 mm!




Tipp: Már a kiadvány készítésének elején állítsa be kiadványszerkesztő programjában a megfelelő mértékű kifutót (bleed), hogy azzal együtt tudjon tervezni, és ne utólag kelljen vele foglalkozni.













Megfelelő a kifutás







Nincs kifutó a vágott méreten kívül
























5.   Felesleges segédjelek




A kiadványszerkesztő programok által a PDF írás során opcionálisan felrakott néhány segédjel az íves ofszet technológia esetén teljesen felesleges, mivel a gyártás során nem oldalanként hanem ívenként történik a nyomtatás így a festék terhelés és a passzer állításra is nyomdánk saját segédjeleket használ, melyek eltérnek a szerkesztő programok által felajánlottaktól. Ezek a felesleges jelek inkább károsak, hiszen megjelenésükkel sokszor fontos millimétereket vesznek el az oldalak kifutóiból, melyek feltétlen szükségesek a gyártástechnológia szempontjából.




Tipp: PDF írásnál kikapcsolhatóak az automatikus jelek használata (Marks and Bleeds). A vágójeleken kívül (Crop marks) ne használjon egyéb jeleket!













Csak vágójel van az oldalon







Felesleges passzerjel és színellenőrző csík, melyek csökkentik a kifutó méretét



















6.   Vágásközeli tartalom




A képeken a zöld szaggatott vonalak a vágások helyét mutatják. Jól látszik hogy az egyik esetben túl közel vannak a tartalmi elemek a vágások pozícióihoz. Ebben az esetben fenn áll a veszélye annak, hogy a technológiából adódó 1-2 milliméteres vágási ingadozások miatt levágódik néhány fontos oldalrészlet. Érdemes tehát a nem kifutásra szánt lényeges tartalmi elemeket legalább 3-4 milliméternyire elhelyezni a leendő vágások helyétől.




Tipp: A kiadványszerkesztő programokban a megfelelő margó beállítások segíthetnek elkerülni a vágáshoz túl közel tervezi fontos elemeket.













Megfelelő távolság a vágás vonalától.







Túl közel a vágáshoz.



















7.   Nem definiált vágás




A vágás helyének pontos meghatározása elengedhetetlen az állományokban, hiszen kifutással együtt a leadott grafikai anyag nagyobb mint a végleges vágott méret, ezért nem mindegy hogy a vágás ezen belül hol történik. A PDF formátum képes metaadatként tartalmazni az úgynevezett trim box beállítást, mely egyértelműen jelezi a vágás helyét. Ezt a beállított trim box méretet a nyomdai PDF workflow szoftverek is képesek értelmezni, és segítségével mindig a megfelelő pozícióba berakni automatikusan a vágójeleket.




Tipp: A tördelőprogramban a dokumentum mérete mindig egyezzen meg a végleges vágott mérettel! Valamint állítsuk be a megfelelő bleed méretet így egyszerűen biztosítható a megfelelő trim box beállítás!













Megfelelően beállított trim box.







Trim box beállítás hiányában nem egyértelmű a körülvágás pontos helye.



















8.   Nem megfelelő színrendszer (RGB)




A nyomdagépek CMYK színrendszerben működnek, ezért a nyomtatandó képeknek is ilyen CMYK színrendszer szerinti kódolásúaknak kell lenniük. A fényképezőgépek és monitorok RGB színrendszerben dolgoznak, ezért a véglegesen leadott anyagban a képeket át kell konvertálni RGB színtérből CMYK-ba. Mivel a két színrendszer által megjeleníthető színek eltérnek egymástól ez a konverzió jellemzően színváltozással járhat, ezért nagyon fontos hogy a konvertálás ne a nyomdában történjen, hanem a képszerkesztés kezdeti fázisában, hogy a színek beállítása a megfelelő színtérben történjen.




Tipp: A színkonverziónál mindig figyeljen a helyes színprofil beállításokra! Egy rosszul beállított ICC színprofil nem megfelelő színbontást eredményezhet! 













Kép CMYK színrendszerben.







Zöld színnel kiemelve azok a területek a képben, amik színezete megváltozik egy RGB-CMYK konverzió hatására.



















9.   Nem megfelelő színprofil (ICC)




Nem megfelelő a színtér, ha a színbontás során nem a nyomtatási technológiának, vagy nem a nyomtatás során használt papírnak megfelelő ICC színprofil alapján történt. A megfelelő színprofilokról bővebb információt talál honlapunkon (ICC Színprofilok) menüpontja alatt. Gyakori hiba, hogy a Photoshop alapértelmezett beállításait megtartva a U.S. Web Coated (SWOP) színprofillal történik a színbontás, amely így nem európai szabványok szerint készül, és nem várt színeltéréseket eredményezhet.




Tipp: Megfelelően kalibrált monitoron nézve az állományt, a megfelelő színprofillal nagyon jó megközelítéssel lehet szimulálni a nyomtatás színeit, ezáltal még a retusálási fázisban korrigálni lehet a képeket a lehető legjobb megjelenés érdekében.













Az adott papírnak megfelelő ICC színprofil.







A nem megfelelő színprofil az állományban színeltérést okozhat a készterméken.



















10.   Rossz felülnyomás




Felülnyomott (overprint) tulajdonságúnak nevezünk egy grafikai elemet, ha az a vele átfedésbe kerülő (alatta levő) egyéb objektumok kitöltését nem befolyásolja. Ha valami nem felülnyomott, akkor “kiüti” (knock out) maga alól a többi objektumot. Mindkét eset lehet jó is és rossz is, ami az adott szituációtól, illetve a kívánt vizuális hatástól is függhet! Azonban nagyon fontos, hogy a papírnyúlás miatt a nem felülnyomott elemek illeszkedése pontatlan is lehet, ezért célszerű az alacsonyabb fokozatú fekete szövegeket, vékony léniákat, vonalkódot stb. mindig felülnyomottra állítani ha azok valamilyen egyéb objektumot fednek! Ugyanakkor kerülendő a “fehér színű” objektumok felülnyomottra állítása, ugyanis ebben az esetben azok eltűnek nyomásnál! Stanckontúr esetén különösen fontos, hogy a stanc elemei minidg overprintre legyenek állítva!




Tipp: A nem várt esetek elkerülése érdekében minden esetben kapcsolja be grafikai programjában az Overprint Preview megjelenítési módot, amely képes szimulálni a felülnyomási beállítások végeredményét.













Felülnyomás (overprint) esetén a fekete szöveg nem üti ki maga alól a zöld hátteret.







Ha nincs felülnyomásra állítva a fekete szöveg (knock out), akkor a zöld háttérből hiányzik negatívan a szöveg, és e miatt a nyomaton a papírnyúlás miatt kilátszódhat a papír fehér színe.



















11. Fehér felülnyomott elemek




A felülnyomottra (overint) állítása a fehér színű elemekre mindig hibás! Ha egy objektum nem felülnyomott, akkor nem üti ki az alatta lévő objektumok színezetét (nem a papír fehér szinezet fog látszódni, hanem az alatta lévő objektum színe). Mivel a fehér színű elemeknek nincs CMYK színezete, ezért ezen beállítás esetén a fehér elem nem tud látszani.




Tipp: Mindig állítsa be úgy a grafikai programjai nézetét, hogy szimulálják a felülnyomást! (View > Overprint Preview)













A fehér elemeknek nem szabad felülnyomottnak lennie!







A fehér felülnyomott elemek nem látszódnak nyomtatásban!



















12. Regisztrációs szín vágott méreten belül




A registration color a grafikai programokban egy speciális szín, amit a nyomtatási jeleknek tartanak fenn. Mivel a nyomtatási jelek (vágójel, passzerjel) minden színt 100% kitöltési arányban kell tartalmaznia, ezért kerülni kell ennek a színnek az alkalmazását az oldal garafikai elemei esetében! 




Tipp: Az egyes felületek színbontását (összfedettségét) egyszerűen ellenőrízheti a kész PDF-ben az Adobe Acrobat Pro DC programban a Tools > Print Production > Output Preview eszköz segyítségével.













Egyszín fekete (100% K)







400% CMYK szín



















13.   Vékony léniák 4 színből




Az ofszet nyomtatás során az egyes színkivonatok (CMYK) a nyomógépben egymást követő műveletek során kerülnek a papírra, ezért fokozottan kell ügyelni az egyes színek egymáshoz való tökéletes illeszkedésére. Valamint a technológia sajátosságaiból adódóan nedvesség is éri a nyomatot, így bizonyos képrészek fokozottan érzékenyek lehetnek a színilleszkedésre és az esetleges papírnyúlásokra. Ilyen elemek a vékony léniák több színből (CMYK színek egymásra nyomva), illetve több színből álló felületekben lévő negatív vékony vonalak.




Tipp: Kerülje a jobb nyomtathatóság érdekében a 0,2 pt-nál vékonyabb léniák használatát több színből vagy negatívba beforgatottan, különösen a több színűből álló vékony rajzolatú, vagy alacsony fokozatú betűk esetén.













Vékony vonalak 100% fekete színkivonatból.







Vékony vonalak 4 színből.



















14.   Túl nagy festék összfedettség




Íves ofszet technológiánál az egymásra nyomtatott színkivonatok (CMYK) százalékos összkitöltési aránya idális esetben nem jó, ha meghaladja a 280%-ot. A 300%-os összfedettségnél több pedig már súlyos nyomtathatósági problémákat okozhat. Ezért kérjük, hogy törekedjen az ilyen jellegű képelemek használatától. Amennyiben nagy felületen van szükség mély fekete nyomtatására javasoljuk, hogy ezeket a felületeket K:100% + C:40% fedettséggel lássa el.




Tipp: Az egyes felületek színbontását (összfedettségét) egyszerűen ellenőrízheti a kész PDF-ben az Adobe Acrobat Pro DC programban a Tools > Print Production > Output Preview eszköz segyítségével.













40% cián színnel mélyített fekete.







326% összfedettségű fekete szín.



















15.   Alacsony felbontás




Alacsony felbontású képnek tekintjük a 150 dpi alatti felbontású képeket. Ezek kerülendőek, mert a monitoron jónak tűnő 72 dpi felbontású kép, a nagyfelbontású (akár 2400 dpi) nyomtatás során már nem tartalmaz elég képrészletet. Ilyen esetekben figyelhető meg az úgynevezett pixelesedés, ami nagyban tudja rontani a késztermék élvezhetőségét. Fontos ezért, hogy megfelelő képanyag kerüljön kiválasztásra, (például az internetről letöltött képek esetén).




Tipp: Ne állítsa át egy rossz minőségű kép felbontását képszerkesztő programban, az eredmény ettől nem lesz jobb minőségű!













300 dpi képfelbontás







72 dpi képfelbontás



















16.   Nem bágyazott font




Mivel a feldolgozás, és rácsrabontás során a PDF-et a RIP programnak pontosan kell tudnia értelmeznie, ezért nagyon fontos, hogy a PDF állomány az ehhez szükséges minden információt tartalmazza. Ezen információk közül az egyik nagyon fontos a használt betűkészletekre vonatkozó információ. Mivel a PDF-et zárt állománynak tekintjük ezért annak tartalmaznia kell beágyazva minden, az értelmezéséhez szükséges információt. A fontbeágyazásnak két alternatívája van, melyek közül a PDF írásakor kell választani. A részleges beágyazás (subset), amikor csak a ténylegesen felhasznált karakterek kerülnek beágyazásra, illetve a teljes betűklészlet beágyazása. 




Tipp: Nagy biztonsággal el lehet kerülni a fontproblémákból eredő hibákat, ha a szövegeket görbévé alakítja a kiadványszerkesztést követően. Ebben az esetben a szövegek nem karakterek, hanem mint vektoros objektumok kerülnek kódolásra az állományban.













Megfelelően beágyazott, vagy görbévé alakított szöveg.







Hibás fontbeágyazás lehetséges következménye.



















17.   Rossz stanckontúr szeparáció




Stancolt termékek esetén fontos, hogy a stancszerszám készítéséhez szükséges stanckontúr megfelelően illeszkedjen a grafikához, de egyszerűen el is lehessen választani attól az állományban, hiszen a nyomtatáskor nem szabad semminek megjelennie a nyomaton a stanckontúr elemeiből. Ezt úgy lehet a legkönnyebben biztosítani, ha a stankontúr elemeit egy elkülönített (a nyomatásnál nem használt) direktszín csatornára tesszük. Fontos továbbá, hogy a kontúr elemei felülnyomottra (overprint) legyenek állítva, így biztosítható, hogy a stancot tartalmazó szeparáció lekapcsolása után sem marad ott negatívból a stanckontúr.




Tipp: Ellenőríze az elkészült PDF-ben lévő stanckontúr beállítását az Adobe Acrobat Pro DC Output Preview-ban történő, a stanckontúrt tartalmazó színcsatorna lekapcsolásával.













Megfelelő szerszám szín direkt színből, felülnyomottan.







CMYK színből kikeverve a szerszám képe megjelenik majd a nyomaton.



















18.   Nem beazonosítható oldal




Nehezen beazonosíthatóak az oldalak (ezáltal veszélyeztetve a megfelelő oldalsorrendet), ha a kiadvány nem tartalmaz oldalszámokat és a leadott állományok nevei alapján nem egyértelmű egy adott oldal pontos elhelyezkedése a kiadványban. Ezért, ha nem egy PDF állományban adja le a teljes kiadvány összes oldalát, akkor fokozottan ügyeljen a fájlok egyértelmű elnevezésére! 




Tipp: Írja bele az állomány nevébe a paginákat! (Például belív15-38.pdf, belív39-45.pdf). Javított oldal feltöltésekor szintén legyen egyértelmű az oldal elnevezés! (Például belív_jav45.pdf)













Az állomány a paginázásnak megfelelően van elnevezve.







Nincs pagina az állományban, és az elnevezésből sem derül ki, hogy pontosan mely oldalakat tartalmazza az állomány.
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